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Skills for Success with Office 2013 Volume 1 (Townsend et al.) 

Excel Chapter 1  Create Workbooks with Excel 2013 

 

1) When Excel opens, a new blank ________ is displayed. 
A) presentation 
B) document 
C) workbook 
D) database 
Answer:  C 
Diff: 1 
Skill:  Excel Chapter 1, Skill 1: Create and Save Workbooks 
 
2) In a workbook, pages are referred to as ________. 
A) subworkbooks 
B) worksheets 
C) pages 
D) gridsheets 
Answer:  B 
Diff: 1 
Skill:  Excel Chapter 1, Skill 1: Create and Save Workbooks 
 
3) In Excel the term worksheet and ________ mean the same thing. 
A) spreadsheet 
B) datasheet 
C) reference sheet 
D) workbook 
Answer:  A 
Diff: 1 
Skill:  Excel Chapter 1, Skill 1: Create and Save Workbooks 
 
4) When identifying a cell as B5, you are using its ________. 
A) worksheet address 
B) grid address 
C) workbook address 
D) cell address 
Answer:  D 
Diff: 2 
Skill:  Excel Chapter 1, Skill 1: Create and Save Workbooks 
 
5) A cell that is outlined in green and has data typed in it is the ________ cell. 
A) home 
B) active 
C) fill 
D) selected 
Answer:  B 
Diff: 1 
Skill:  Excel Chapter 1, Skill 1: Create and Save Workbooks 
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6) When a cell is active, its column and row headings are ________. 
A) flashing 
B) hidden 
C) bolded 
D) shaded 
Answer:  D 
Diff: 2 
Skill:  Excel Chapter 1, Skill 1: Create and Save Workbooks 
 
7) The bar, located below the Ribbon, that displays the active cell's content is the ________. 
A) formula bar 
B) name bar 
C) data bar 
D) display bar 
Answer:  A 
Diff: 2 
Skill:  Excel Chapter 1, Skill 2: Enter Data and Merge and Center Titles 
 
8) The cell content shown in the formula bar is referred to as the ________ value. 
A) displayed 
B) actual 
C) underlying 
D) hidden 
Answer:  C 
Diff: 2 
Skill:  Excel Chapter 1, Skill 2: Enter Data and Merge and Center Titles 
 
9) If content exists in cell B1, and a long text value is entered into cell A1, the A1 display is 
________. 
A) wrapped 
B) truncated 
C) hidden 
D) deleted 
Answer:  B 
Diff: 2 
Skill:  Excel Chapter 1, Skill 2: Enter Data and Merge and Center Titles 
 
10) Two or more adjacent cells in a worksheet are a(n) ________. 
A) unit 
B) group 
C) range 
D) array 
Answer:  C 
Diff: 2 
Skill:  Excel Chapter 1, Skill 2: Enter Data and Merge and Center Titles 
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11) Which cells are included in the notation A1:D1? 
A) A1, B1, and C1 
B) B1, C1, and D1 
C) A1 and D1 
D) A1, B1, C1, and D1 
Answer:  D 
Diff: 3 
Skill:  Excel Chapter 1, Skill 2: Enter Data and Merge and Center Titles 
 
12) Which symbol inserted between two cell addresses indicates a range? 
A) colon 
B) semi-colon 
C) period 
D) comma 
Answer:  A 
Diff: 3 
Skill:  Excel Chapter 1, Skill 2: Enter Data and Merge and Center Titles 
 
13) The Merge & Center button is in the ________ group on the Home tab. 
A) Font 
B) Alignment 
C) Number 
D) Cells 
Answer:  B 
Diff: 1 
Skill:  Excel Chapter 1, Skill 2: Enter Data and Merge and Center Titles 
 
14) When a range is selected, the name box displays the cell address of ________. 
A) the first cell in the range 
B) the last cell in the range 
C) all cells in the range 
D) none of the cells in the range 
Answer:  A 
Diff: 2 
Skill:  Excel Chapter 1, Skill 2: Enter Data and Merge and Center Titles 
 
15) An underlying value that does mathematical calculations on numeric values in a worksheet is 
________. 
A) the Formula AutoComplete 
B) a formula 
C) a text value 
D) a cell address 
Answer:  B 
Diff: 2 
Skill:  Excel Chapter 1, Skill 3: Construct Addition and Subtraction Formulas 
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16) The ________ displays a list of functions that match the first letter typed. 
A) Formula AutoComplete feature 
B) edit feature 
C) Quick Access Toolbar 
D) formula bar 
Answer:  A 
Diff: 2 
Skill:  Excel Chapter 1, Skill 3: Construct Addition and Subtraction Formulas 
 
17) When a cell is part of an active function, it is ________. 
A) surrounded by a solid border 
B) highlighted 
C) surrounded by a moving border 
D) preceded by an Options button 
Answer:  C 
Diff: 2 
Skill:  Excel Chapter 1, Skill 3: Construct Addition and Subtraction Formulas 
 
18) Placing content in a cell can be done by pressing the Enter key or by clicking the ________. 
A) Cancel button 
B) Enter button 
C) Esc key 
D) column header 
Answer:  B 
Diff: 2 
Skill:  Excel Chapter 1, Skill 3: Construct Addition and Subtraction Formulas 
 
19) The symbol on the Enter button is a(n) ________. 
A) right arrow 
B) left arrow 
C) x 
D) checkmark 
Answer:  D 
Diff: 1 
Skill:  Excel Chapter 1, Skill 3: Construct Addition and Subtraction Formulas 
 
20) When a formula is in an active cell, the underlying formula is visible in the ________. 
A) Name Box 
B) worksheet 
C) formula bar 
D) status bar 
Answer:  C 
Diff: 2 
Skill:  Excel Chapter 1, Skill 4: Construct Multiplication and Division Formulas 
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21) Themed Cell Styles is an option in the ________. 
A) Conditional Formatting gallery 
B) Cell Styles gallery 
C) Format gallery 
D) Format as Table gallery 
Answer:  B 
Diff: 2 
Skill:  Excel Chapter 1, Skill 5: Adjust Column Widths and Apply Cell Styles 
 
22) Which feature displays the formatting of the style moused over in the Cell Styles gallery on 
the selected cells in the worksheet? 
A) Print Preview 
B) Display Preview 
C) Live Preview 
D) Layout Preview 
Answer:  C 
Diff: 3 
Skill:  Excel Chapter 1, Skill 5: Adjust Column Widths and Apply Cell Styles 
 
23) Which is an example of an Excel function? 
A) =D6 + D7 + D8 
B) =D7/D20 
C) =SUM(D6:D8) 
D) =D5*100 
Answer:  C 
Diff: 2 
Skill:  Excel Chapter 1, Skill 6: Insert the SUM Function 
 
24) The ________ button inserts a function that sums selected cells. 
A) AutoAdd 
B) AutoSum 
C) AutoCalculate 
D) Fill 
Answer:  B 
Diff: 2 
Skill:  Excel Chapter 1, Skill 6: Insert the SUM Function 
 
25) When no cells are selected and the AutoSum button is clicked, Excel first looks ________ 
the active cell for a suitable range to sum. 
A) above 
B) below 
C) to the right of  
D) to the left of 
Answer:  A 
Diff: 2 
Skill:  Excel Chapter 1, Skill 6: Insert the SUM Function 
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26) Which cells are included in the sum calculated by the function =SUM(D5:G5)? 
A) D5, E5, and F5 
B) E5, F5, and G5 
C) E5 and F5 
D) D5, E5, F5, and G5 
Answer:  D 
Diff: 3 
Skill:  Excel Chapter 1, Skill 6: Insert the SUM Function 
 
27) Which term is used to refer to automatic adjustment of cell references in a copied formula? 
A) associative cell reference 
B) absolute cell reference 
C) relative cell reference 
D) positional cell reference 
Answer:  C 
Diff: 2 
Skill:  Excel Chapter 1, Skill 7: AutoFill Formulas and Data 
 
28) When a row is inserted into a worksheet, the ________ of the row above is applied to the 
inserted row. 
A) text value 
B) formatting 
C) numeric value 
D) formula 
Answer:  B 
Diff: 2 
Skill:  Excel Chapter 1, Skill 7: AutoFill Formulas and Data 
 
29) After the fill handle is used to copy cell content, the ________ button appears to the right of 
the selected cells. 
A) Auto Fill Options 
B) Fill Handle Options 
C) Quick Copy Options 
D) Quick Fill Options 
Answer:  A 
Diff: 2 
Skill:  Excel Chapter 1, Skill 7: AutoFill Formulas and Data 
 
30) Which is NOT an option in the Auto Fill Options menu? 
A) Copy Cells 
B) Fill Series 
C) Paste Cells 
D) Fill Format Only 
Answer:  C 
Diff: 3 
Skill:  Excel Chapter 1, Skill 7: AutoFill Formulas and Data 
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31) Select the ________ option from the Auto Fill Options menu to keep numeric values 
unchanged when using the fill handle. 
A) Copy Cells 
B) Fill Series 
C) Fill Format Only 
D) Fill Without Formatting 
Answer:  A 
Diff: 3 
Skill:  Excel Chapter 1, Skill 7: AutoFill Formulas and Data 
 
32) Which number format adds commas where appropriate and displays two decimals? 
A) Currency 
B) Comma 
C) General 
D) Percentage 
Answer:  B 
Diff: 2 
Skill:  Excel Chapter 1, Skill 8: Format, Edit, and Check Spelling 
 
33) Number formats can be adjusted with options in the Styles and ________ groups on the 
Home tab. 
A) Font 
B) Number 
C) Cells 
D) Editing 
Answer:  B 
Diff: 2 
Skill:  Excel Chapter 1, Skill 8: Format, Edit, and Check Spelling 
 
34) Non-adjacent cells can be selected in a worksheet by holding down the ________ key. 
A) Alt 
B) Home 
C) Ctrl 
D) Shift 
Answer:  C 
Diff: 2 
Skill:  Excel Chapter 1, Skill 8: Format, Edit, and Check Spelling 
 
35) Pressing ________ makes A1 the active cell. 
A) Home 
B) Ctrl + Home 
C) Ctrl + Left Arrow 
D) Ctrl + Right Arrow 
Answer:  B 
Diff: 2 
Skill:  Excel Chapter 1, Skill 8: Format, Edit, and Check Spelling 
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36) The ________ option in the Spelling dialog box inserts a word identified as misspelled into 
the Office dictionary. 
A) AutoCorrect 
B) Change 
C) Change All 
D) Add to Dictionary 
Answer:  D 
Diff: 2 
Skill:  Excel Chapter 1, Skill 8: Format, Edit, and Check Spelling 
 
37) Headers and footers are visible in the ________ view. 
A) Normal 
B) Page Layout 
C) Page Break Preview 
D) Full Screen 
Answer:  B 
Diff: 2 
Skill:  Excel Chapter 1, Skill 9: Insert Footers and Adjust Page Settings 
 
38) Options to insert a field (e.g., a filename) into a header or footer are in the ________ group 
of the Design contextual tab. 
A) Header & Footer 
B) Header & Footer Elements 
C) Navigation 
D) Options 
Answer:  B 
Diff: 2 
Skill:  Excel Chapter 1, Skill 9: Insert Footers and Adjust Page Settings 
 
39) Placeholders for predefined headers and footers begin with ________. 
A) & 
B) # 
C) @ 
D) $ 
Answer:  A 
Diff: 3 
Skill:  Excel Chapter 1, Skill 9: Insert Footers and Adjust Page Settings 
 
40) When the Center on page Horizontally option is checked on the Margins tab of the Page 
Setup dialog box, the worksheet cells with content are ________. 
A) centered between the left and right margins 
B) centered between the top and bottom margins 
C) centered between the left and right edges of the printed page 
D) centered between the top and bottom edges of the printed page 
Answer:  A 
Diff: 3 
Skill:  Excel Chapter 1, Skill 9: Insert Footers and Adjust Page Settings 



 

9 

Copyright © 2014 Pearson Education, Inc. 

41) When formulas are displayed in a worksheet, what happens? 
A) Column width is increased. 
B) Row height is increased. 
C) Left and right margins are decreased. 
D) Top and bottom margins are decreased. 
Answer:  A 
Diff: 2 
Skill:  Excel Chapter 1, Skill 10: Display Formulas and Print Worksheets 
 
42) Labels are text data values entered at the top of a column or the beginning of a row to clarify 
the data in the worksheet.  
Answer:  TRUE 
Diff: 2 
Skill:  Excel Chapter 1, Skill 1: Create and Save Workbooks 
 
43) In a worksheet, columns have numerical headings and rows have alphabetical headings. 
Answer:  FALSE 
Diff: 2 
Skill:  Excel Chapter 1, Skill 1: Create and Save Workbooks 
 
44) In a worksheet, pressing Enter after entering data in cell B5, makes cell C5 the active cell. 
Answer:  FALSE 
Diff: 2 
Skill:  Excel Chapter 1, Skill 1: Create and Save Workbooks 
 
45) Text values and number values are two types of data that can be entered in a worksheet's cell. 
Answer:  TRUE 
Diff: 2 
Skill:  Excel Chapter 1, Skill 1: Create and Save Workbooks 
 
46) Directional arrow keys can be used to move the active cell indicator in the direction of the 
arrow. 
Answer:  TRUE 
Diff: 1 
Skill:  Excel Chapter 1, Skill 1: Create and Save Workbooks 
 
47) The terms displayed value and underlying value are always synonymous. 
Answer:  FALSE 
Diff: 2 
Skill:  Excel Chapter 1, Skill 2: Enter Data and Merge and Center Titles 
 
48) A long text value in a cell overlaps into the display of adjacent columns when the cells in the 
adjacent columns are empty. 
Answer:  TRUE 
Diff: 2 
Skill:  Excel Chapter 1, Skill 2: Enter Data and Merge and Center Titles 
 



 

10 

Copyright © 2014 Pearson Education, Inc. 

49) When a range is selected, a thick green line surrounds the range, and all cells except the first 
cell are shaded. 
Answer:  TRUE 
Diff: 2 
Skill:  Excel Chapter 1, Skill 2: Enter Data and Merge and Center Titles 

50) Individual cells can be selected in a range of cells that have been merged. 
Answer:  FALSE 
Diff: 2 
Skill:  Excel Chapter 1, Skill 2: Enter Data and Merge and Center Titles 
 
51) When the first entry in a cell is an equal sign, clicking another cell automatically enters that 
cell's address after the equal sign as part of the formula being created. 
Answer:  TRUE 
Diff: 2 
Skill:  Excel Chapter 1, Skill 3: Construct Addition and Subtraction Formulas 
 
52) If an error is made entering a formula, the Enter key can be pressed to remove the contents 
and start over. 
Answer:  FALSE 
Diff: 2 
Skill:  Excel Chapter 1, Skill 3: Construct Addition and Subtraction Formulas 
 
53) Using the Enter button to confirm a cell entry keeps that cell the active cell. 
Answer:  TRUE 
Diff: 2 
Skill:  Excel Chapter 1, Skill 3: Construct Addition and Subtraction Formulas 
 
54) Using the Enter key to confirm a cell entry makes the cell to the right the active cell. 
Answer:  FALSE 
Diff: 2 
Skill:  Excel Chapter 1, Skill 3: Construct Addition and Subtraction Formulas 
 
55) When content is being copied from one range of cells to another, all source cells need to be 
selected before the Copy button is clicked, and all destination cells need to be selected before the 
Paste button is clicked. 
Answer:  FALSE 
Diff: 2 
Skill:  Excel Chapter 1, Skill 4: Construct Multiplication and Division Formulas 
 
56) Default row height and default column width CANNOT be altered by the user. 
Answer:  FALSE 
Diff: 2 
Skill:  Excel Chapter 1, Skill 5: Adjust Column Widths and Apply Cell Styles 
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57) Double -clicking on a cell displays the shortcut menu and Mini toolbar. 
Answer:  FALSE 
Diff: 2 
Skill:  Excel Chapter 1, Skill 5: Adjust Column Widths and Apply Cell Styles 
 
58) When the numeric value in a cell changes, any formula or function in the worksheet 
containing that cell reference is automatically recalculated. 
Answer:  TRUE 
Diff: 2 
Skill:  Excel Chapter 1, Skill 6: Insert the SUM Function 

59) The fill handle is used to copy content to adjacent cells. 
Answer:  TRUE 
Diff: 3 
Skill:  Excel Chapter 1, Skill 7: AutoFill Formulas and Data 
 
60) The fill handle appears in all four corners of a selection. 
Answer:  FALSE 
Diff: 2 
Skill:  Excel Chapter 1, Skill 7: AutoFill Formulas and Data 
 
61) The fill handle can be used to copy content ONLY into adjacent columns. 
Answer:  FALSE 
Diff: 2 
Skill:  Excel Chapter 1, Skill 7: AutoFill Formulas and Data 
 
62) A row or column is inserted into a worksheet at the location of the selected cell or cells. 
Answer:  TRUE 
Diff: 3 
Skill:  Excel Chapter 1, Skill 7: AutoFill Formulas and Data 
 
63) When a new row or column is inserted in a range of cells used in a function, the range in the 
function is not automatically adjusted to include that new row or column. 
Answer:  FALSE 
Diff: 2 
Skill:  Excel Chapter 1, Skill 7: AutoFill Formulas and Data 
 
64) The content of a cell can be edited in the worksheet by double-clicking the cell. 
Answer:  TRUE 
Diff: 2 
Skill:  Excel Chapter 1, Skill 8: Format, Edit, and Check Spelling 
 
65) The Increase Decimal and Decrease Decimal buttons actually add or remove decimal places 
to the underlying value in a cell. 
Answer:  FALSE 
Diff: 2 
Skill:  Excel Chapter 1, Skill 8: Format, Edit, and Check Spelling 
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66) A word identified as misspelled in the Spelling dialog box may actually be spelled correctly. 
Answer:  TRUE 
Diff: 2 
Skill:  Excel Chapter 1, Skill 8: Format, Edit, and Check Spelling 
 
67) The Spelling dialog box does NOT suggest corrections for words identified as misspelled. 
Answer:  FALSE 
Diff: 2 
Skill:  Excel Chapter 1, Skill 8: Format, Edit, and Check Spelling 
 
68) When the header or the footer of a worksheet is active, the Header & Footer Tools Layout 
contextual tab appears on the Ribbon. 
Answer:  FALSE 
Diff: 2 
Skill:  Excel Chapter 1, Skill 9: Insert Footers and Adjust Page Settings 

69) In Normal View, headers and footers are displayed on the monitor. 
Answer:  FALSE 
Diff: 2 
Skill:  Excel Chapter 1, Skill 9: Insert Footers and Adjust Page Settings 
 
70) Worksheet headers and footers are divided into three sections—left, middle, right. 
Answer:  TRUE 
Diff: 3 
Skill:  Excel Chapter 1, Skill 9: Insert Footers and Adjust Page Settings 
 
71) Dotted page break lines appear in a worksheet after it is viewed in Print Preview. 
Answer:  TRUE 
Diff: 3 
Skill:  Excel Chapter 1, Skill 9: Insert Footers and Adjust Page Settings 
 
72) Underlying formulas and functions can be displayed in a worksheet and printed. 
Answer:  TRUE 
Diff: 2 
Skill:  Excel Chapter 1, Skill 10: Display Formulas and Print Worksheets 
 
73) Clarify data in a row or column by typing a(n) ________ at the beginning of the row or 
column. 
Answer:  label 
Diff: 2 
Skill:  Excel Chapter 1, Skill 1: Create and Save Workbooks 
 
74) In a worksheet the intersection of a column and row is a(n) ________. 
Answer:  cell 
Diff: 1 
Skill:  Excel Chapter 1, Skill 1: Create and Save Workbooks 
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75) What is the address of the cell where the third column and fourth row intersect? 
Answer:  C4 
Diff: 2 
Skill:  Excel Chapter 1, Skill 1: Create and Save Workbooks 
 
76) What is the address of the cell in the upper leftmost corner of a worksheet? 
Answer:  A1 
Diff: 2 
Skill:  Excel Chapter 1, Skill 1: Create and Save Workbooks 
 
77) If the Tab key is pressed when B7 is the active cell, ________ will become the active cell. 
Answer:  C7 
Diff: 2 
Skill:  Excel Chapter 1, Skill 1: Create and Save Workbooks 
 
78) Text values are aligned at the ________ cell edge. 
Answer:  left 
Diff: 1 
Skill:  Excel Chapter 1, Skill 1: Create and Save Workbooks 

79) Number values are aligned at the ________ cell edge. 
Answer:  right 
Diff: 1 
Skill:  Excel Chapter 1, Skill 1: Create and Save Workbooks 
 
80) Pressing Ctrl + Home keys makes ________ the active cell. 
Answer:  A1 
Diff: 2 
Skill:  Excel Chapter 1, Skill 1: Create and Save Workbooks 
 
81) The ________ bar can be used to enter and edit content. 
Answer:  formula 
Diff: 2 
Skill:  Excel Chapter 1, Skill 2: Enter Data and Merge and Center Titles 
 
82) The data visible in the worksheet is the ________ value. 
Answer:  displayed 
Diff: 2 
Skill:  Excel Chapter 1, Skill 2: Enter Data and Merge and Center Titles 
 
83) The cell reference of an active cell is displayed, to the left of the formula bar, in the 
________. 
Answer:  name box 
Diff: 2 
Skill:  Excel Chapter 1, Skill 2: Enter Data and Merge and Center Titles 
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84) A formula in a worksheet begins with a(n) ________. 
Answer:  equal sign 
Diff: 1 
Skill:  Excel Chapter 1, Skill 3: Construct Addition and Subtraction Formulas 
 
85) A symbol for an operation—like a + for addition or a - for subtraction—is a(n) ________.  
Answer:  arithmetic operator 
Diff: 2 
Skill:  Excel Chapter 1, Skill 3: Construct Addition and Subtraction Formulas 
 
86) When a formula has a cell reference, the ________ value of the cell is used in the formula 
calculation. 
Answer:  displayed 
Diff: 2 
Skill:  Excel Chapter 1, Skill 3: Construct Addition and Subtraction Formulas 
 
87) Formula AutoComplete displays a list of ________ names. 
Answer:  function 
Diff: 2 
Skill:  Excel Chapter 1, Skill 3: Construct Addition and Subtraction Formulas 
 
88) The symbol on the Cancel button is a(n) ________. 
Answer:   x 
Diff: 1 
Skill:  Excel Chapter 1, Skill 3: Construct Addition and Subtraction Formulas 

89) The ________ key performs the same function that the Cancel button does. 
Answer:  Esc 
Diff: 3 
Skill:  Excel Chapter 1, Skill 3: Construct Addition and Subtraction Formulas 
 
90) The Copy button is in the ________ group of the Home tab. 
Answer:  Clipboard 
Diff: 1 
Skill:  Excel Chapter 1, Skill 4: Construct Multiplication and Division Formulas 
 
91) In an Excel formula, a(n) ________ is the arithmetic operator for multiplication. 
Answer:  asterisk 
Diff: 1 
Skill:  Excel Chapter 1, Skill 4: Construct Multiplication and Division Formulas 
 
92) Row height and column width can be adjusted by clicking the ________ button on the Home 
tab. 
Answer:  Format 
Diff: 1 
Skill:  Excel Chapter 1, Skill 5: Adjust Column Widths and Apply Cell Styles 
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93) The letter D in the cell address D5 refers to ________. 
Answer:  column heading 
Diff: 2 
Skill:  Excel Chapter 1, Skill 5: Adjust Column Widths and Apply Cell Styles 
 
94) The ________ button can be used to combine a selected row of cells into a single cell that 
spans multiple columns. 
Answer:  Merge & Center  
Diff: 2 
Skill:  Excel Chapter 1, Skill 5: Adjust Column Widths and Apply Cell Styles 
 
95) A prewritten Excel formula that uses values, performs arithmetic operations, and returns a 
value is a(n) ________. 
Answer:  function 
Diff: 2 
Skill:  Excel Chapter 1, Skill 6: Insert the SUM Function 
 
96) If the numeric values in cells B1:B9 are selected, and row 10 is empty when the AutoSum 
button is clicked, the sum of the range (B1:B9) appears in cell ________. 
Answer:  B10 
Diff: 3 
Skill:  Excel Chapter 1, Skill 6: Insert the SUM Function 
 
97) If cell B7 includes the formula =B5 + B6, and the fill handle is used to copy the formula to 
cell C7, what is the underlying formula in cell C7? 
Answer:  =C5 + C6 
Diff: 3 
Skill:  Excel Chapter 1, Skill 7: AutoFill Formulas and Data 

98) When numeric values are copied with the fill handle, and the ________ option is selected in 
the Auto Fill Options menu, the numeric values are increased by one. 
Answer:  Fill Series 
Diff: 3 
Skill:  Excel Chapter 1, Skill 7: AutoFill Formulas and Data 
 
99) The Increase Decimal button and the Decrease Decimal button are in the ________ group on 
the Home tab. 
Answer:  Number 
Diff: 2 
Skill:  Excel Chapter 1, Skill 8: Format, Edit, and Check Spelling 
 
100) The ________ number format multiplies the displayed number format of the cell by 100. 
Answer:  Percent 
Diff: 2 
Skill:  Excel Chapter 1, Skill 8: Format, Edit, and Check Spelling 
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101) Before the Spelling button is clicked, it is useful to make ________ the active cell. 
Answer:  A1 
Diff: 2 
Skill:  Excel Chapter 1, Skill 8: Format, Edit, and Check Spelling 
 
102) The Header & Footer button is in the Text group on the ________ tab. 
Answer:  Insert 
Diff: 1 
Skill:  Excel Chapter 1, Skill 9: Insert Footers and Adjust Page Settings 
 
103) In Normal View, clicking the Header & Footer button changes the worksheet view to 
________. 
Answer:  Page Layout 
Diff: 2 
Skill:  Excel Chapter 1, Skill 9: Insert Footers and Adjust Page Settings 
 
104) When a predefined header or footer is inserted into a worksheet, a(n) ________ is used to 
provide instructions for printing. 
Answer:  placeholder 
Diff: 2 
Skill:  Excel Chapter 1, Skill 9: Insert Footers and Adjust Page Settings 
 
105) The dimensions of a printed worksheet can be adjusted with ________ so that the 
worksheet prints on a specified number of pages. 
Answer:  scaling 
Diff: 2 
Skill:  Excel Chapter 1, Skill 10: Display Formulas and Print Worksheets 
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Match the worksheet term with its corresponding meaning. 

 
A) Data displayed in the formula bar 
B) Data displayed in a worksheet cell 
C) Two or more adjacent cells in a worksheet 
D) Feature that displays a portion of text content in a cell 
E) Area that displays active cell reference 
 
106) Displayed value  
Diff: 2 
Skill: Excel Chapter 1, Skill 2: Enter Data and Merge and Center Titles 
 
107) Underlying value 
Diff: 2 
Skill: Excel Chapter 1, Skill 2: Enter Data and Merge and Center Titles 
 
108) Range 
Diff: 2 
Skill:  Excel Chapter 1, Skill 2: Enter Data and Merge and Center Titles 
 
109) Name Box 
Diff: 2 
Skill:  Excel Chapter 1, Skill 2: Enter Data and Merge and Center Titles 
 
110) Truncate 
Diff: 2 
Skill:  Excel Chapter 1, Skill 2: Enter Data and Merge and Center Titles 
 
Answers: 106) B 107) A 108) C 109) E 110) D 
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Match the worksheet feature with its action. 

 
A) Automatic adjustment of cell references in formulas or functions that are copied 
B) Auto Fill Option that copies numeric content without incrementing values 
C) Small green square in lower right corner of selection 
D) Auto Fill Option that automatically increments, by one, copied numeric values 
 
111) Fill handle 
Diff: 2 
Skill:  Excel Chapter 1, Skill 7: AutoFill Formulas and Data 
 
112) Copy Cells 
Diff: 2 
Skill: Excel Chapter 1, Skill 7: AutoFill Formulas and Data 
 
113) Fill Series 
Diff: 2 
Skill:  Excel Chapter 1, Skill 7: AutoFill Formulas and Data 
 
114) Relative cell reference 
Diff: 2 
Skill:  Excel Chapter 1, Skill 7: AutoFill Formulas and Data 

Answers: 111) C 112) B 113) D 114) A 
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Skills for Success with Office 2013 Volume 1 (Townsend et al.) 

PowerPoint Chapter 1  Getting Started with PowerPoint 2013 

 

1) ________ are miniature images of the presentation slides. 

A) Scroll boxes 

B) Thumbnails 

C) ScreenTips 

D) Templates 

Answer:  B 

Diff: 1 

Skill:  PowerPoint Chapter 1, Skill 1: Open, View, and Save Presentations 

 

2) Use ________ to increase the list level of a bullet point. 

A) Enter 

B) [Ctrl] + [Alt] 

C) Tab 

D) [Shift] + [Tab] 

Answer:  C 

Diff: 2 

Skill:  PowerPoint Chapter 1, Skill 2: Edit and Replace Text 

 

3) ________ are a set of characters with the same design and shape.  

A) Letters 

B) Fonts 

C) Graphics 

D) Markers 

Answer:  B 

Diff: 1 

Skill:  PowerPoint Chapter 1, Skill 3: Format Slide Text 

 

4) The ________ pane provides an option for hearing how a word is pronounced.  

A) Spelling 

B) Left 

C) Slide 

D) Right 

Answer:  A 

Diff: 3 

Skill:  PowerPoint Chapter 1, Skill 4: Check Spelling and Use the Thesaurus 

 

5) The ________ gallery contains several content layouts you can apply to a slide. 

A) Themes 

B) Chart 

C) Layout 

D) Shapes 

Answer:  C 

Diff: 1 

Skill:  PowerPoint Chapter 1, Skill 5: Insert Slides and Modify Slide Layouts 
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6) The ________ tab displays when you have an image selected. 

A) Picture Tools 

B) Table Tools 

C) Chart Tools 

D) SmartArt Tools 

Answer:  A 

Diff: 1 

Skill:  PowerPoint Chapter 1, Skill 6: Insert and Format Pictures 

 

7) Using ________ enables the user to select a group of non-continuous slides. 

A) [Alt] 

B) [Ctrl] 

C) [Ctrl] + [Shift] 

D) [Shift] 

Answer:  B 

Diff: 2 

Skill:  PowerPoint Chapter 1, Skill 7: Organize Slides in Slide Sorter View 

 

8) Slide ________ are motion effects that occur in a slide show as you move from one slide to 

the next. 

A) options 

B) animations 

C) transitions 

D) effects 

Answer:  C 

Diff: 1 

Skill:  PowerPoint Chapter 1, Skill 8: Apply Slide Transitions and View Slide Shows 

 

9) From the Start screen you can ________. 

A) delete a presentation 

B) insert a table 

C) view a list of recently opened presentations 

D) rearrange slides 

Answer:  C 

Diff: 2 

Skill:  PowerPoint Chapter 1, Skill 1: Open, View, and Save Presentations 

 

10) You can choose a template for a new presentation from the ________. 

A) Start screen 

B) Slide pane 

C) Lock screen 

D) Ribbon 

Answer:  A 

Diff: 2 

Skill:  PowerPoint Chapter 1, Skill 1: Open, View, and Save Presentations 
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11) Which of the following is NOT displayed on the status bar? 

A) Comments button 

B) Fit slide to current window button 

C) Link to open other presentations 

D) Zoom level 

Answer:  C 

Diff: 3 

Skill:  PowerPoint Chapter 1, Skill 1: Open, View, and Save Presentations 

 

12) Bullet ________ are individual lines of bullet text on a slide. 

A) points 

B) details 

C) levels 

D) records 

Answer:  A 

Diff: 1 

Skill:  PowerPoint Chapter 1, Skill 2: Edit and Replace Text 

 

13) A(n) ________ is a hierarchy of bullets and sub-bullets. 

A) alphabetic level 

B) list level 

C) chronological list 

D) detail list 

Answer:  B 

Diff: 1 

Skill:  PowerPoint Chapter 1, Skill 2: Edit and Replace Text 

 

14) In the Replace dialog box, the ________ box is where you enter the replacement text. 

A) Replace with 

B) Locate text 

C) Edit text 

D) Find what 

Answer:  A 

Diff: 2 

Skill:  PowerPoint Chapter 1, Skill 2: Edit and Replace Text 

 

15) A font is measured in ________. 

A) centimeters 

B) leading 

C) serifs 

D) points 

Answer:  D 

Diff: 2 

Skill:  PowerPoint Chapter 1, Skill 3: Format Slide Text 
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16) The ________ button center aligns text within a placeholder. 

A) Justify 

B) Align Left 

C) Center 

D) Align Right 

Answer:  C 

Diff: 3 

Skill:  PowerPoint Chapter 1, Skill 3: Format Slide Text 

 

17) Font ________ and effects emphasize text and include bold, italic, underline, shadow, and 

outline. 

A) styles 

B) face 

C) pitch 

D) lists 

Answer:  A 

Diff: 2 

Skill:  PowerPoint Chapter 1, Skill 3: Format Slide Text 

 

18) The thesaurus is a research tool that provides a list of ________. 

A) homonyms 

B) synonyms 

C) antonyms 

D) acronyms 

Answer:  B 

Diff: 2 

Skill:  PowerPoint Chapter 1, Skill 4: Check Spelling and Use the Thesaurus 

 

19) You can correct spelling errors using the ________ or the spell check feature. 

A) shortcut menu 

B) index pane 

C) Mini toolbar 

D) Research dialog box 

Answer:  A 

Diff: 3 

Skill:  PowerPoint Chapter 1, Skill 4: Check Spelling and Use the Thesaurus 

 

20) A slide's ________ is the arrangement of the text and graphic elements or placeholders on 

that slide.  

A) layout 

B) theme 

C) style 

D) outline 

Answer:  A 

Diff: 2 

Skill:  PowerPoint Chapter 1, Skill 5: Insert Slides and Modify Slide Layouts 
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21) The ________ gallery is a visual representation of several content layouts that can be applied 

to a slide. 

A) Design 

B) Transition 

C) Animation 

D) Layout 

Answer:  D 

Diff: 2 

Skill:  PowerPoint Chapter 1, Skill 5: Insert Slides and Modify Slide Layouts 

 

22) ________ is NOT a slide layout. 

A) Two Content 

B) Title and Content 

C) Graphic 

D) Blank 

Answer:  C 

Diff: 3 

Skill:  PowerPoint Chapter 1, Skill 5: Insert Slides and Modify Slide Layouts 

 

23) Which of the following is a graphic file extension? 

A) .ppt 

B) .png 

C) .txt 

D) .docx 

Answer:  B 

Diff: 3 

Skill:  PowerPoint Chapter 1, Skill 6: Insert and Format Pictures 

 

24) Sizing handles are ________ surrounding a selected object that can be used to adjust its size. 

A) squares or circles 

B) circles or triangles 

C) arrows or squares 

D) triangles or arrows 

Answer:  A 

Diff: 2 

Skill:  PowerPoint Chapter 1, Skill 6: Insert and Format Pictures 

 

25) Which view allows you to apply formatting to multiple slides? 

A) Zoom 

B) Normal 

C) Reading 

D) Slide Sorter 

Answer:  D 

Diff: 2 

Skill:  PowerPoint Chapter 1, Skill 7: Organize Slides in Slide Sorter View 
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26) When a slide is selected in Slide Sorter view, a(n) ________ surrounds the slide, indicating it 

is selected. 

A) dashed line 

B) outline 

C) dotted line 

D) circle 

Answer:  B 

Diff: 2 

Skill:  PowerPoint Chapter 1, Skill 7: Organize Slides in Slide Sorter View 

 

27) A ________ displays at the end of the slide show to indicate that the presentation is over. 

A) black slide 

B) conclusion slide 

C) white slide 

D) summary slide 

Answer:  A 

Diff: 2 

Skill:  PowerPoint Chapter 1, Skill 8: Apply Slide Transitions and View Slide Shows 

 

28) Slide ________ are printed images of slides on a sheet of paper. 

A) screenshots 

B) handouts 

C) notes pages 

D) outlines 

Answer:  B 

Diff: 2 

Skill:  PowerPoint Chapter 1, Skill 8: Apply Slide Transitions and View Slide Shows 

 

29) In the Header and Footer dialog box, a slide ________ appears on each slide if the option is 

selected. 

A) outline 

B) summary 

C) table 

D) number 

Answer:  D 

Diff: 2 

Skill:  PowerPoint Chapter 1, Skill 9: Insert Headers and Footers and Print Handouts 

 

30) The Notes pane is an area of the ________ View window used to type notes that can be 

printed below an image of the slide. 

A) Slide Sorter 

B) Reading 

C) Normal 

D) Slide Show 

Answer:  C 

Diff: 2 

Skill:  PowerPoint Chapter 1, Skill 10: Add Notes Pages and Use Presenter View 
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31) The Start screen allows you to open an existing presentation. 

Answer:  TRUE 

Diff: 1 

Skill:  PowerPoint Chapter 1, Skill 1: Open, View, and Save Presentations 

32) Pressing Enter at the end of a bullet point adds a new bullet at the next list level. 

Answer:  FALSE 

Diff: 3 

Skill:  PowerPoint Chapter 1, Skill 2: Edit and Replace Text 

 

33) Live Preview lets you see a font style or effect before it is applied.  

Answer:  TRUE 

Diff: 1 

Skill:  PowerPoint Chapter 1, Skill 3: Format Slide Text 

 

34) PowerPoint does NOT give you an option to add words to the dictionary. 

Answer:  FALSE 

Diff: 2 

Skill:  PowerPoint Chapter 1, Skill 4: Check Spelling and Use the Thesaurus 

 

35) You can set the layout when you insert a slide using the New Slide button. 

Answer:  TRUE 

Diff: 1 

Skill:  PowerPoint Chapter 1, Skill 5: Insert Slides and Modify Slide Layouts 

 

36) Perspective Shadow, White is a picture style. 

Answer:  TRUE 

Diff: 3 

Skill:  PowerPoint Chapter 1, Skill 6: Insert and Format Pictures 

 

37) Slide Sorter view can be used to reorganize a presentation. 

Answer:  TRUE 

Diff: 2 

Skill:  PowerPoint Chapter 1, Skill 7: Organize Slides in Slide Sorter View 

 

38) If you have a conservative audience, it is best to select transitions from the Dynamic Content 

group. 

Answer:  FALSE 

Diff: 3 

Skill:  PowerPoint Chapter 1, Skill 8: Apply Slide Transitions and View Slide Shows 

 

39) A footer displaying on slides automatically displays on handouts as well. 

Answer:  FALSE 

Diff: 3 

Skill:  PowerPoint Chapter 1, Skill 9: Insert Headers and Footers and Print Handouts 
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40) A slide can contain text, pictures, tables, charts, and other multimedia or graphic objects. 

Answer:  TRUE 

Diff: 1 

Skill:  PowerPoint Chapter 1, Skill 1: Open, View, and Save Presentations 

 

41) A ScreenTip displays the slide number and the number of slides in the presentation. 

Answer:  FALSE 

Diff: 3 

Skill:  PowerPoint Chapter 1, Skill 1: Open, View, and Save Presentations 

42) Right-click a slide thumbnail to display it in the Slide pane. 

Answer:  FALSE 

Diff: 2 

Skill:  PowerPoint Chapter 1, Skill 1: Open, View, and Save Presentations 

 

43) The right side of the PowerPoint window displays Next Slide and Previous Slide buttons. 

Answer:  TRUE 

Diff: 2 

Skill:  PowerPoint Chapter 1, Skill 1: Open, View, and Save Presentations 

 

44) The dotted border of placeholders is visible at all times. 

Answer:  FALSE 

Diff: 2 

Skill:  PowerPoint Chapter 1, Skill 2: Edit and Replace Text 

 

45) The Edit command allows you to change multiple occurrences of the same text in a 

presentation. 

Answer:  FALSE 

Diff: 1 

Skill:  PowerPoint Chapter 1, Skill 2: Edit and Replace Text 

 

46) In the Replace dialog box, the Find what box is where you type the text you want to replace 

the previous text. 

Answer:  FALSE 

Diff: 2 

Skill:  PowerPoint Chapter 1, Skill 2: Edit and Replace Text 

 

47) A solid border around a placeholder indicates that the entire placeholder and all of its 

contents are selected. 

Answer:  TRUE 

Diff: 1 

Skill:  PowerPoint Chapter 1, Skill 3: Format Slide Text 
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48) You can use the Ribbon, the status bar, or the Font dialog box to apply font styles and 

effects. 

Answer:  FALSE 

Diff: 2 

Skill:  PowerPoint Chapter 1, Skill 3: Format Slide Text 

 

49) Justify is an example of text alignment. 

Answer:  TRUE 

Diff: 2 

Skill:  PowerPoint Chapter 1, Skill 3: Format Slide Text 

 

50) A word with a green wavy underline indicates a spelling error. 

Answer:  FALSE 

Diff: 2 

Skill:  PowerPoint Chapter 1, Skill 4: Check Spelling and Use the Thesaurus 

 

51) The Spelling pane checks the spelling of an entire presentation. 

Answer:  TRUE 

Diff: 2 

Skill:  PowerPoint Chapter 1, Skill 4: Check Spelling and Use the Thesaurus 

52) The dictionary is a research tool that provides a list of words with the same meaning. 

Answer:  FALSE 

Diff: 3 

Skill:  PowerPoint Chapter 1, Skill 4: Check Spelling and Use the Thesaurus 

 

53) When the upper half of the New Slide button is clicked, a new slide is inserted with the same 

layout as the previous slide. 

Answer:  TRUE 

Diff: 2 

Skill:  PowerPoint Chapter 1, Skill 5: Insert Slides and Modify Slide Layouts 

 

54) The New Slide button is divided into three parts. 

Answer:  FALSE 

Diff: 3 

Skill:  PowerPoint Chapter 1, Skill 5: Insert Slides and Modify Slide Layouts 

 

55) The number of slide layouts is NOT the same for each slide design. 

Answer:  TRUE 

Diff: 2 

Skill:  PowerPoint Chapter 1, Skill 5: Insert Slides and Modify Slide Layouts 

 

56) You can resize an image proportionally by using the middle sizing handle. 

Answer:  FALSE 

Diff: 2 

Skill:  PowerPoint Chapter 1, Skill 6: Insert and Format Pictures 
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57) .rtf is an example of a graphic file extension. 

Answer:  FALSE 

Diff: 2 

Skill:  PowerPoint Chapter 1, Skill 6: Insert and Format Pictures 

 

58) The Picture Tools contextual tab displays only when an image is selected. 

Answer:  TRUE 

Diff: 1 

Skill:  PowerPoint Chapter 1, Skill 6: Insert and Format Pictures 

 

59) Slide Sorter view displays all the slides in a presentation as thumbnails. 

Answer:  TRUE 

Diff: 2 

Skill:  PowerPoint Chapter 1, Skill 7: Organize Slides in Slide Sorter View 

 

60) On a touch screen device, you can touch one time with your fingertip to select a slide. 

Answer:  TRUE 

Diff: 2 

Skill:  PowerPoint Chapter 1, Skill 7: Organize Slides in Slide Sorter View 

 

61) A wavy border surrounds a selected slide in Slide Sorter view. 

Answer:  FALSE 

Diff: 2 

Skill:  PowerPoint Chapter 1, Skill 7: Organize Slides in Slide Sorter View 

62) During a presentation, you CANNOT control the speed with which slides advance. 

Answer:  FALSE 

Diff: 2 

Skill:  PowerPoint Chapter 1, Skill 8: Apply Slide Transitions and View Slide Shows 

 

63) Slide transition groups include Subtle, Exciting, and Dynamic Content. 

Answer:  TRUE 

Diff: 2 

Skill:  PowerPoint Chapter 1, Skill 8: Apply Slide Transitions and View Slide Shows 

 

64) When a presentation is viewed as a slide show, the entire slide fills the screen. 

Answer:  TRUE 

Diff: 1 

Skill:  PowerPoint Chapter 1, Skill 8: Apply Slide Transitions and View Slide Shows 

 

65) A footer is text that prints at the top of each page of slide handouts. 

Answer:  FALSE 

Diff: 1 

Skill:  PowerPoint Chapter 1, Skill 9: Insert Headers and Footers and Print Handouts 
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66) Transparent is NOT an option in which slides may display when printed. 

Answer:  TRUE 

Diff: 2 

Skill:  PowerPoint Chapter 1, Skill 9: Insert Headers and Footers and Print Handouts 

 

67) Users can add headers to slides but NOT to handouts. 

Answer:  FALSE 

Diff: 3 

Skill:  PowerPoint Chapter 1, Skill 9: Insert Headers and Footers and Print Handouts 

 

68) You CANNOT read notes on the screen. 

Answer:  FALSE 

Diff: 1 

Skill:  PowerPoint Chapter 1, Skill 10: Add Notes Pages and Use Presenter View 

 

69) Presenter view requires only one monitor. 

Answer:  TRUE 

Diff: 2 

Skill:  PowerPoint Chapter 1, Skill 10: Add Notes Pages and Use Presenter View 

 

70) Presenter view displays the slide, speaker notes, and a thumbnail of the next slide. 

Answer:  TRUE 

Diff: 2 

Skill:  PowerPoint Chapter 1, Skill 10: Add Notes Pages and Use Presenter View 

 

71) The ________ displays when you start PowerPoint 2013. 

Answer:  Start screen 

Diff: 2 

Skill:  PowerPoint Chapter 1, Skill 1: Open, View, and Save Presentations 

72) A(n) ________ is an individual page in a presentation. 

Answer:  slide 

Diff: 1 

Skill:  PowerPoint Chapter 1, Skill 1: Open, View, and Save Presentations 

 

73) ________ are part of the slide layout that hold text or objects. 

Answer:  Placeholders 

Diff: 2 

Skill:  PowerPoint Chapter 1, Skill 2: Edit and Replace Text 

 

74) Bullet points are organized in a hierarchy similar to a(n) ________. 

Answer:  outline 

Diff: 2 

Skill:  PowerPoint Chapter 1, Skill 2: Edit and Replace Text 
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75) A(n) ________ is measured in points. 

Answer:  font 

Diff: 2 

Skill:  PowerPoint Chapter 1, Skill 3: Format Slide Text 

 

76) With ________, lowercase characters are capitalized but are smaller than characters typed as 

capital letters. 

Answer:  small caps 

Diff: 2 

Skill:  PowerPoint Chapter 1, Skill 3: Format Slide Text 

 

77) ________ are squares or circles surrounding a selected object that can be used to adjust its 

size. 

Answer:  Sizing handles 

Diff: 2 

Skill:  PowerPoint Chapter 1, Skill 6: Insert and Format Pictures 

 

78) Select a group of sequential slides using ________. 

Answer:  Shift 

Diff: 3 

Skill:  PowerPoint Chapter 1, Skill 7: Organize Slides in Slide Sorter View 

 

79) ________ are miniature images of the presentation slides. 

Answer:  Thumbnails 

Diff: 1 

Skill:  PowerPoint Chapter 1, Skill 1: Open, View, and Save Presentations 

 

80) The ________ indicates the displayed slide number and the number of slides in the 

presentation. 

Answer:  status bar 

Diff: 2 

Skill:  PowerPoint Chapter 1, Skill 1: Open, View, and Save Presentations 

 

81) The ________ indicates the relative location in the presentation of the slide being viewed. 

Answer:  vertical scroll bar 

Diff: 2 

Skill:  PowerPoint Chapter 1, Skill 1: Open, View, and Save Presentations 

82) In ________ view, the PowerPoint window is divided into two areas—the Slide pane and the 

left pane. 

Answer:  Normal 

Diff: 1 

Skill:  PowerPoint Chapter 1, Skill 1: Open, View, and Save Presentations 
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83) A set of characters with the same design and shape is a(n) ________. 

Answer:  font 

Diff: 2 

Skill:  PowerPoint Chapter 1, Skill 3: Format Slide Text 

 

84) Text ________ is the placement of text within a placeholder. 

Answer:  alignment 

Diff: 1 

Skill:  PowerPoint Chapter 1, Skill 3: Format Slide Text 

 

85) Words with the same meaning are called ________. 

Answer:  synonyms 

Diff: 1 

Skill:  PowerPoint Chapter 1, Skill 4: Check Spelling and Use the Thesaurus 

 

86) Names such as Paris, Sharon, or Microsoft, also known as ________ names, are sometimes 

flagged as misspelled, even though they are spelled correctly. 

Answer:  proper 

Diff: 3 

Skill:  PowerPoint Chapter 1, Skill 4: Check Spelling and Use the Thesaurus 

 

87) Words marked with a(n) ________ wavy underline are misspelled. 

Answer:  red 

Diff: 2 

Skill:  PowerPoint Chapter 1, Skill 4: Check Spelling and Use the Thesaurus 

 

88) PowerPoint includes several predefined ________ used to arrange slide elements. 

Answer:  layouts 

Diff: 2 

Skill:  PowerPoint Chapter 1, Skill 5: Insert Slides and Modify Slide Layouts 

 

89) The keyboard shortcut ________ inserts a new slide into a presentation. 

Answer:  [Ctrl] + [M]  

Diff: 3 

Skill:  PowerPoint Chapter 1, Skill 5: Insert Slides and Modify Slide Layouts 

 

90) Pointing to a(n) ________ sizing handle displays a horizontal resize pointer. 

Answer:  square 

Diff: 3 

Skill:  PowerPoint Chapter 1, Skill 6: Insert and Format Pictures 

 

91) ________ a slide thumbnail to rearrange its position in Slide Sorter view. 

Answer:  Drag 

Diff: 2 

Skill:  PowerPoint Chapter 1, Skill 7: Organize Slides in Slide Sorter View 
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92) To return to Normal view, ________-click a slide in Slide Sorter view. 

Answer:  double 

Diff: 2 

Skill:  PowerPoint Chapter 1, Skill 7: Organize Slides in Slide Sorter View 

 

93) Slide ________ are organized as Subtle, Exciting, and Dynamic Content. 

Answer:  transitions 

Diff: 2 

Skill:  PowerPoint Chapter 1, Skill 8: Apply Slide Transitions and View Slide Shows 

 

94) The Snipping Tool is an application used to create screenshots called ________. 

Answer:  snips 

Diff: 1 

Skill:  PowerPoint Chapter 1, Skill 9: Insert Headers and Footers and Print Handouts 

 

95) The lower half of Notes pages for any slides that do not contain notes remains ________. 

Answer:  blank 

Diff: 2 

Skill:  PowerPoint Chapter 1, Skill 10: Add Notes Pages and Use Presenter View 
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Match each definition with the appropriate term. 

 

A) Outline view 

B) Slide thumbnails 

C) Recently opened presentations 

D) Tabs 

E) Notes pane 

F) Lock screen 

G) Title bar 

H) Mini toolbar 

I) Status bar 

J) Vertical scroll bar 

 

96) Located on the Ribbon 

Diff: 2 

Skill:  PowerPoint Chapter 1, Skill 1: Open, View, and Save Presentations 

 

97) Located on the right side of the PowerPoint window 

Diff: 2 

Skill:  PowerPoint Chapter 1, Skill 1: Open, View, and Save Presentations 

 

98) Located at the bottom of the PowerPoint window 

Diff: 2 

Skill:  PowerPoint Chapter 1, Skill 1: Open, View, and Save Presentations 

 

99) Located at the left side of the PowerPoint window 

Diff: 2 

Skill:  PowerPoint Chapter 1, Skill 1: Open, View, and Save Presentations 

 

100) Located on the PowerPoint Start screen 

Diff: 2 

Skill:  PowerPoint Chapter 1, Skill 1: Open, View, and Save Presentations 

 

Answers: 96) D 97) J 98) I 99) B 100) C 
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Skills for Success with Office 2013 Volume 1 (Townsend et al.) 

Word Chapter 1  Create Letters and Memos 

 

1) A new paragraph can be created in a document by pressing the ________ key. 

A) Home 

B) End 

C) Insert 

D) Enter 

Answer:  D 

Diff: 1 

Skill:  Word Chapter 1, Skill 1: Type Letter Text  

 

2) Clicking the Show/Hide button on the Home tab of the Ribbon displays ________. 

A) Clipboard content 

B) formatting marks 

C) headers and footers 

D) styles applied to the document 

Answer:  B 

Diff: 2 

Skill:  Word Chapter 1, Skill 1: Type Letter Text 

 

3) Wavy red and green lines that appear below segments of text indicate ________. 

A) a style change from previous text 

B) the start of a new paragraph 

C) flagged errors 

D) presence of formatting marks 

Answer:  C 

Diff: 2 

Skill:  Word Chapter 1, Skill 2: Apply Styles and Set Grammar and Spelling Options 

 

4) Pressing Ctrl + Home moves the insertion point to ________. 

A) the beginning of the current line 

B) the beginning of the document 

C) the end of the current line 

D) the end of the document 

Answer:  B 

Diff: 1 

Skill:  Word Chapter 1, Skill 2: Apply Styles and Set Grammar and Spelling Options 

 

5) Pressing Ctrl + S is the keyboard alternative to clicking the ________ button.  

A) Show/Hide 

B) Split Window 

C) Save 

D) Switch Window 

Answer:  C 

Diff: 1 

Skill:  Word Chapter 1, Skill 2: Apply Styles and Set Grammar and Spelling Options 
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6) Normal and No Spacing are prebuilt collections of formatting settings that can be applied to 

text by selecting them from the ________ group on the Home tab.  

A) Styles 

B) Font 

C) Paragraph 

D) Editing 

Answer:  A 

Diff: 1 

Skill:  Word Chapter 1, Skill 2: Apply Styles and Set Grammar and Spelling Options 

 

7)  Errors flagged by the Spelling and Grammar checker can be customized in the ________ 

section of the Word Options dialog box. 

A) General 

B) Display 

C) Advanced 

D) Proofing 

Answer:  D 

Diff: 3 

Skill:  Word Chapter 1, Skill 2: Apply Styles and Set Grammar and Spelling Options 

 

8) When a word in a document is selected and moused over, the transparent ________ tool bar, 

which displays common formatting options, appears. 

A) Mini 

B) Layout 

C) Quick Access 

D) Font 

Answer:  A 

Diff: 3 

Skill:  Word Chapter 1, Skill 3: Select and Insert Text 

 

9) Click the ________ to remove the most recent formatting setting applied to a section of the 

document or to the entire document. 

A) Normal style option 

B) Show /Hide button 

C) Undo button 

D) Redo button 

Answer:  C 

Diff: 2 

Skill:  Word Chapter 1, Skill 3: Select and Insert Text 
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10) The Select All feature used to highlight all the text in a document appears on the Home tab in 

the ________ group. 

A) Font 

B) Paragraph 

C) Styles 

D) Editing 

Answer:  D 

Diff: 1 

Skill:  Word Chapter 1, Skill 3: Select and Insert Text 

11) A manual page break can be inserted into a document by clicking ________ and then Page in 

the Page Layout tab.  

A) Orientation 

B) Breaks 

C) Margins 

D) Spacing 

Answer:  B 

Diff: 2 

Skill:  Word Chapter 1, Skill 4: Copy, Cut, and Paste Text 

 

12) Click the ________ button, in the Clipboard group, on the Home tab to insert a copy of the 

text or object stored in the Clipboard. 

A) Show/Hide 

B) Replace 

C) Paste 

D) Format Painter 

Answer:  C 

Diff: 1 

Skill:  Word Chapter 1, Skill 4: Copy, Cut, and Paste Text 

 

13) Definitions are displayed in the ________ to help the user decide which suggested word is 

the correct replacement for a flagged error. 

A) Spelling pane 

B) Grammar pane 

C) shortcut menu 

D) Margin 

Answer:  A 

Diff: 2 

Skill:  Word Chapter 1, Skill 5: Check Spelling and Grammar 
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14) During document proofreading, the suggestion to insert an apostrophe to indicate possessive 

use would appear in the ________. 

A) Spelling pane 

B) Grammar pane 

C) Margin 

D) Proofing pane 

Answer:  B 

Diff: 2 

Skill:  Word Chapter 1, Skill 5: Check Spelling and Grammar 

 

15) The Recheck Document button, which resets the Spelling and Grammar checker to flag 

previously ignored errors, is located in the ________. 

A) Navigation pane 

B) Proofing group of the Review tab 

C) Tracking group of the Review tab 

D) Word Options dialog box 

Answer:  D 

Diff: 3 

Skill:  Word Chapter 1, Skill 6: Check Writing Style and Insert Synonyms 

16) The ________ lists words that have a meaning the same as or similar to that of the word 

being looked up. 

A) Spelling pane 

B) Grammar pane 

C) Thesaurus 

D) shortcut menu 

Answer:  C 

Diff: 2 

Skill:  Word Chapter 1, Skill 6: Check Writing Style and Insert Synonyms 

 

17) If a document has several topics, and the first topic heading is set in 15-point bold Cambria 

type, the ________ button(s) can be used to apply those settings to all of the other topic 

headings. 

A) Copy and Paste 

B) Cut and Paste 

C) Format Painter 

D) Text Effects 

Answer:  C 

Diff: 3 

Skill:  Word Chapter 1, Skill 7: Use Format Painter 
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18) To apply a group of formatting settings to multiple nonconsecutive sections of text in a 

document,  ________ the Format Painter button. 

A) single-click 

B) double-click 

C) triple-click 

D) right-click 

Answer:  B 

Diff: 2 

Skill:  Word Chapter 1, Skill 7: Use Format Painter 

 

19) The Format Painter is located in the ________ group on the Home tab. 

A) Styles 

B) Paragraph 

C) Editing 

D) Clipboard 

Answer:  D 

Diff: 1 

Skill:  Word Chapter 1, Skill 7: Use Format Painter 

 

20) Which formatting option is used to apply a set of decorative features to characters? 

A) Text Effects 

B) Highlight Color 

C) Font Color 

D) Font 

Answer:  A 

Diff: 2 

Skill:  Word Chapter 1, Skill 7: Use Format Painter 

21) Which formatting option is used to shade the background of characters? 

A) Font Color 

B) Highlight Color 

C) Font 

D) Bold 

Answer:  B 

Diff: 2 

Skill:  Word Chapter 1, Skill 7: Use Format Painter 

 

22) The flagging of an uncommon last name as a spelling error can be stopped by opening the 

shortcut menu on the first occurrence of the name and selecting ________. 

A) Ignore 

B) Ignore All 

C) AutoCorrect 

D) Spelling 

Answer:  B 

Diff: 3 

Skill:  Word Chapter 1, Skill 2: Apply Styles and Set Grammar and Spelling Options 
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23) EXCEPT for ________, all of the following are a text effect in the Font dialog box. 

A) Small caps 

B) All caps 

C) Hidden 

D) Outline 

Answer:  D 

Diff: 1 

Skill:  Word Chapter 1, Skill 8: Apply Advanced Font Settings 

 

24) The option for adjusting character spacing is on the Advanced tab of the ________ dialog 

box. 

A) Clipboard 

B) Font 

C) Paragraph 

D) Styles 

Answer:  B 

Diff: 3 

Skill:  Word Chapter 1, Skill 8: Apply Advanced Font Settings 

 

25) Font size and between-character spacing is measured in ________. 

A) inches 

B) centimeters 

C) millimeters 

D) points 

Answer:  D 

Diff: 2 

Skill:  Word Chapter 1, Skill 8: Apply Advanced Font Settings 

26) One inch equals ________ points. 

A) 25 

B) 47 

C) 72 

D) 100 

Answer:  C 

Diff: 2 

Skill:  Word Chapter 1, Skill 8: Apply Advanced Font Settings 

 

27) Which is NOT a feature of the Save As page? 

A) Choosing a storage location 

B) Choosing a folder 

C) Publishing the document as a blog 

D) Naming the file 

Answer:  C 

Diff: 3 

Skill:  Word Chapter 1, Skill 1: Type Letter Text 
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28) Dialog boxes are launched from ________. 

A) the Quick Access toolbar. 

B) their Ribbon group. 

C) a shortcut menu that appears when a Ribbon group is right-clicked 

D) the Mini toolbar 

Answer:  B 

Diff: 3 

Skill:  Word Chapter 1, Skill 8: Apply Advanced Font Settings 

 

29) Adobe Acrobat can be used to view Word files if they are saved with file extension 

________. 

A) .doc 

B) .docx 

C) .pdf 

D) .html 

Answer:  C 

Diff: 3 

Skill:  Word Chapter 1, Skill 10: Save Documents as PDF Files 

 

30) One or more pages can be viewed without scrolling by ________. 

A) adjusting the zoom level 

B) changing the settings in the Print/Print Preview dialog box 

C) changing the settings in the Word Options dialog box 

D) doing nothing (the program automatically adjusts page views) 

Answer:  A 

Diff: 3 

Skill:  Word Chapter 1, Skill 10: Save Documents as PDF Files 

31) The option for adjust zoom level, which is used to view multiple pages of a document, is 

located in the ________ tab of the Ribbon. 

A) Home 

B) Page Layout 

C) Review 

D) View 

Answer:  D 

Diff: 1 

Skill:  Word Chapter 1, Skill 10: Save Documents as PDF Files 

 

32) The term ________ refers to highlighting text by double-clicking, triple-clicking, or clicking 

and dragging so that the highlighted content can be edited. 

A) pointing 

B) selecting 

C) marking 

D) choosing 

Answer:  B 

Diff: 2 

Skill:  Word Chapter 1, Skill 3: Select and Insert Text 
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33) Expanding or stretching text is an option located on the Advanced tab of the ________ 

dialog box.  

A) Paragraph  

B) Clipboard 

C) Font  

D) Styles 

Answer:  C 

Diff: 3 

Skill:  Word Chapter 1, Skill 8: Apply Advanced Font Settings 

 

34) The area that is reserved for text, graphics, and fields  and that by default displays at the 

bottom of each page in a document is the ________. 

A) header 

B) footer 

C) endnote 

D) footnote 

Answer:  B 

Diff: 2 

Skill:  Word Chapter 1, Skill 9: Create Document Footers 

 

35) The Header and Footer buttons are located on the ________ tab. 

A) Home 

B) Insert 

C) Review 

D) View 

Answer:  B 

Diff: 2 

Skill:  Word Chapter 1, Skill 9: Create Document Footers 

36) A tab that appears on the right side of the Ribbon only when certain objects are selected or 

when the insertion point is in a specific area of the document (e.g., header, footer) is called a(n) 

________ tab. 

A) options 

B) formatting 

C) content 

D) contextual 

Answer:  D 

Diff: 3 

Skill:  Word Chapter 1, Skill 9: Create Document Footers 
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37) When the insertion point is in the footer, a Header & Footer Tools ________ contextual tab 

appears on the right side of the ribbon. 

A) Design 

B) Format 

C) Layout 

D) Edit 

Answer:  A 

Diff: 3 

Skill:  Word Chapter 1, Skill 9: Create Document Footers 

 

38) A selected field is shaded in ________.  

A) blue 

B) black 

C) gray 

D) red 

Answer:  C 

Diff: 3 

Skill:  Word Chapter 1, Skill 9: Create Document Footers 

 

39) Which of these would NOT be flagged as a spelling error? 

A) jane 

B) Giardino 

C) Im 

D) an incorrect verb form 

Answer:  D 

Diff: 2 

Skill:  Word Chapter 1, Skill 5: Check Spelling and Grammar 

 

40) With formatting marks hidden, it is easier to see ________. 

A) how the document will appear when printed 

B) where paragraphs begin and end in the document 

C) the spacing between words in the document 

D) where section breaks appear in the document 

Answer:  A 

Diff: 2 

Skill:  Word Chapter 1, Skill 10: Save Documents as PDF Files 

41) A zoom level of 52% usually displays ________ page(s). 

A) one 

B) two 

C) three 

D) four 

Answer:  B 

Diff: 3 

Skill:  Word Chapter 1, Skill 10: Save Documents as PDF Files 

 



 

10 

Copyright © 2014 Pearson Education, Inc. 

42) EXCEPT for ________, all of the following are formatting marks. 

A) paragraphs 

B) spaces 

C) tabs 

D) line spacing 

Answer:  D 

Diff: 2 

Skill:  Word Chapter 1, Skill 1: Type Letter Text 

 

43) When a new document is being saved for the first time, the Save icon is clicked, and 

________. 

A) the document is given a default file name and is auto-saved in a default location 

B) the Save As dialog box opens 

C) an error message appears and indicates that an incorrect choice was made 

D) Word closes the document without saving (the user never saved and named the document) 

Answer:  B 

Diff: 1 

Skill:  Word Chapter 1, Skill 1: Type Letter Text 

 

44) In the Save As dialog box, the user specifies all these EXCEPT the ________. 

A) location for storing the document 

B) orientation of the document 

C) folder in which to store the document 

D) file name for the document 

Answer:  B 

Diff: 2 

Skill:  Word Chapter 1, Skill 1: Type Letter Text 

 

45) A word repetition—two identical words in a row—is ________. 

A) flagged as a spelling error 

B) flagged as a grammar error 

C) not considered an error and not flagged 

D) indicated by a Mini toolbar 

Answer:  A 

Diff: 1 

Skill:  Word Chapter 1, Skill 2: Apply Styles and Set Grammar and Spelling Options 

 

46) The formatting marks in a document NEVER print. 

Answer:  TRUE 

Diff: 2 

Skill:  Word Chapter 1, Skill 1: Type Letter Text 

47) A single paragraph can be selected by triple-clicking in the paragraph. 

Answer:  TRUE 

Diff: 1 

Skill:  Word Chapter 1, Skill 3: Select and Insert Text 
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48) When a word is selected with a double-click and deleted, both the word and the space after it 

are deleted. 

Answer:  TRUE 

Diff: 3 

Skill:  Word Chapter 1, Skill 3: Select and Insert Text 

 

49) Paste options are displayed by clicking the Paste arrow. 

Answer:  TRUE 

Diff: 3 

Skill:  Word Chapter 1, Skill 4: Copy, Cut, and Paste Text 

 

50) Typing while text is selected inserts the typed text above the selected content. 

Answer:  FALSE 

Diff: 3 

Skill:  Word Chapter 1, Skill 3: Select and Insert Text 

 

51) Text formatting helps organize a document visually without detracting from the meaning. 

Answer:  TRUE 

Diff: 2 

Skill:  Word Chapter 1, Skill 7: Use Format Painter 

 

52) Before the Format Painter button is clicked, the insertion point needs to be on the text 

formatted with the settings that are to be applied to other text in the document. 

Answer:  TRUE 

Diff: 2 

Skill:  Word Chapter 1, Skill 7: Use Format Painter 

 

53) The Format Painter button behaves NO differently on being single-clicked versus double-

clicked. 

Answer:  FALSE 

Diff: 2 

Skill:  Word Chapter 1, Skill 7: Use Format Painter 

 

54) Dialog boxes often contain content not on the Ribbon. 

Answer:  TRUE 

Diff: 2 

Skill:  Word Chapter 1, Skill 8: Apply Advanced Font Settings 

 

55) Before paragraph formatting is applied to a single paragraph, the ENTIRE paragraph must be 

selected. 

Answer:  FALSE 

Diff: 2 

Skill:  Word Chapter 1, Skill 3: Select and Insert Text 
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56) The Undo button is located on the Home tab of the Ribbon. 

Answer:  FALSE 

Diff: 2 

Skill:  Word Chapter 1, Skill 3: Select and Insert Text 

 

57) Press the Esc key to hide the Paste Options button, which appears after content is pasted 

from the Clipboard. 

Answer:  TRUE 

Diff: 3 

Skill:  Word Chapter 1, Skill 4: Copy, Cut, and Paste Text 

 

58) In some cases, the message indicating completion of the Spelling and Grammar check does 

not appear, and typing errors might still exist in the document. 

Answer:  TRUE 

Diff: 3 

Skill:  Word Chapter 1, Skill 5: Check Spelling and Grammar 

 

59) A single-click the Format Painter button is all that is needed to apply a group of formatting 

settings from one paragraph to another. 

Answer:  TRUE 

Diff: 2 

Skill:  Word Chapter 1, Skill 7: Use Format Painter 

 

60) Regarding flagged errors, use of the passive voice is identified as a grammar error. 

Answer:  TRUE 

Diff: 3 

Skill:  Word Chapter 1, Skill 5: Check Spelling and Grammar 

 

61) Regarding flagged errors, a word used where the possessive form of the word should have 

been used is identified as a spelling error. 

Answer:  FALSE 

Diff: 3 

Skill:  Word Chapter 1, Skill 5: Check Spelling and Grammar 

 

62) Consistency is one advantage of using a style provided by Word, as opposed to applying 

individual formatting to multiple sections of text. 

Answer:  TRUE 

Diff: 2 

Skill:  Word Chapter 1, Skill 2: Apply Styles and Set Grammar and Spelling Options 

 

63) It is a good idea to run the Spelling and Grammar checker after all text in a document is 

typed. 

Answer:  TRUE 

Diff: 2 

Skill:  Word Chapter 1, Skill 5: Check Spelling and Grammar 
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64) Even though it is not required, it is a good idea to start the Spelling and Grammar checker 

with the insertion point at the end of the document. 

Answer:  FALSE 

Diff: 2 

Skill:  Word Chapter 1, Skill 5: Check Spelling and Grammar 

65) Text can be deselected by pressing the Esc key. 

Answer:  FALSE 

Diff: 2 

Skill:  Word Chapter 1, Skill 3: Select and Insert Text 

 

66) The Text Effects options in the Font group of the Home tab are identical to the Effects 

options in the Font tab of the Font dialog box. 

Answer:  FALSE 

Diff: 3 

Skill:  Word Chapter 1, Skill 8: Apply Advanced Font Settings 

 

67) Files with the .docx extension appear in the Publish as PDF or XPS dialog box. 

Answer:  FALSE 

Diff: 3 

Skill:  Word Chapter 1, Skill 10: Save Documents as PDF Files 

 

68) An advantage of publishing a Word document as a PDF document is that users who do not 

have Word can open and read the PDF document. 

Answer:  TRUE 

Diff: 2 

Skill:  Word Chapter 1, Skill 10: Save Documents as PDF Files 

 

69) The Format Painter uses the Clipboard to temporarily hold the group of formatting settings 

being applying to sections of the document. 

Answer:  FALSE 

Diff: 3 

Skill:  Word Chapter 1, Skill 4: Copy, Cut, and Paste Text 

 

70) The user who is closing a document and wants it to later reopen as it currently appears 

should click Save when prompted to save changes. 

Answer:  TRUE 

Diff: 2 

Skill:  Word Chapter 1, Skill 10: Save Documents as PDF Files 

 

71) An organization's letterhead is formatted the same as the text in the body of the document. 

Answer:  FALSE 

Diff: 2 

Skill:  Word Chapter 1, Skill 8: Apply Advanced Font Settings 
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72) Word provides built-in headers and footers but also allows them to be customized. 

Answer:  TRUE 

Diff: 2 

Skill:  Word Chapter 1, Skill 9: Create Document Footers 

 

73) The document header can be made active by single-clicking in the header area. 

Answer:  FALSE 

Diff: 1 

Skill:  Word Chapter 1, Skill 9: Create Document Footers 

74) The document text and the footer text can be active at the same time. 

Answer:  FALSE 

Diff: 2 

Skill:  Word Chapter 1, Skill 9: Create Document Footers 

 

75) The result of typing a name, pressing the Enter key twice, and typing the date is the name on 

one line, the date on one line, and two blank lines in between. 

Answer:  FALSE 

Diff: 1 

Skill:  Word Chapter 1, Skill 1: Type Letter Text 

 

76) A document can be closed by clicking the Close icon in its Thumbnail on the taskbar. 

Answer:  TRUE 

Diff: 2 

Skill:  Word Chapter 1, Skill 4: Copy, Cut, and Paste Text 

 

77) Words that the user adds to the custom dictionary in one document are flagged as errors in 

documents created later. 

Answer:  FALSE 

Diff: 2 

Skill:  Word Chapter 1, Skill 5: Check Spelling and Grammar 

 

78) Additional dictionaries, accessed through the user's Microsoft account, can be useful aids in 

proofreading. 

Answer:  TRUE 

Diff: 2 

Skill:  Word Chapter 1, Skill 5: Check Spelling and Grammar 

 

79) In a document, flagged errors are identified by red and green exclamation points. 

Answer:  FALSE 

Diff: 1 

Skill:  Word Chapter 1, Skill 2: Apply Styles and Set Grammar and Spelling Options 

 

80) The spacing between letter elements in a document is specified by style rules. 

Answer:  TRUE 

Diff: 3 

Skill:  Word Chapter 1, Skill 3: Select and Insert Text 
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81) The ________ format option applies extra thickness to characters to emphasize text. 

Answer:  bold 

Diff: 1 

Skill:  Word Chapter 1, Skill 7: Use Format Painter 

 

82) The ________ style is the default style for a new Word document. 

Answer:  Normal 

Diff: 2 

Skill:  Word Chapter 1, Skill 2: Apply Styles and Set Grammar and Spelling Options 

 

83) A button that turns a feature both on and off is called a(n) ________ button. 

Answer:  toggle 

Diff: 1 

Skill:  Word Chapter 1, Skill 1: Type Letter Text 

84) Color is applied to the characters in a document with the ________ format option. 

Answer:  Font color 

Diff: 1 

Skill:  Word Chapter 1, Skill 7: Use Format Painter 

 

85) Triple-clicking on a section of text selects the ________. 

Answer:  paragraph 

Diff: 2 

Skill:  Word Chapter 1, Skill 3: Select and Insert Text 

 

86) A Home tab feature that copies a group of formatting settings from one section of text and 

applies it to other sections of text in the same document is the ________. 

Answer:  Format Painter 

Diff: 2 

Skill:  Word Chapter 1, Skill 7: Use Format Painter 

 

87) The file extension on a PDF document is ________. 

Answer:  .pdf 

Diff: 1 

Skill:  Word Chapter 1, Skill 10: Save Documents as PDF Files 

 

88) A document that can be read by Adobe Acrobat instead of Word is a(n) ________. 

Answer:  PDF document 

Diff: 2 

Skill:  Word Chapter 1, Skill 10: Save Documents as PDF Files 

 

89) The content affected by the Copy and Cut buttons is temporarily stored in the ________. 

Answer:  Clipboard 

Diff: 2 

Skill:  Word Chapter 1, Skill 4: Copy, Cut, and Paste Text 
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90) The area that is reserved for text, graphics, and fields and that by default displays at the top 

of each page in a document is a(n) ________. 

Answer:  header 

Diff: 1 

Skill:  Word Chapter 1, Skill 9: Create Document Footers 

 

91) Footer content that is not obtained from the Footer gallery but is instead entered by the user 

is a(n) ________ footer. 

Answer:  custom 

Diff: 2 

Skill:  Word Chapter 1, Skill 9: Create Document Footers 

 

92) The footer can be made active by using the ________ option on the Footer button. 

Answer:  Edit Footer 

Diff: 2 

Skill:  Word Chapter 1, Skill 9: Create Document Footers 

93) A category of data (e.g., file name, page number, current date) that can be inserted into a 

document is a(n) ________. 

Answer:  field 

Diff: 2 

Skill:  Word Chapter 1, Skill 9: Create Document Footers 

 

94) When multiple pages are displayed by zooming in, best fit is calculated based on ________. 

Answer:  monitor size 

Diff: 3 

Skill:  Word Chapter 1, Skill 10: Save Documents as PDF Files 

 

95) The original zoom level set in most documents is ________ percent. 

Answer:  100 

Diff: 3 

Skill:  Word Chapter 1, Skill 10: Save Documents as PDF Files 

 

96) When the Show/Hide button is clicked in a new, blank document, the only formatting mark 

displayed is for a(n) ________. 

Answer:  paragraph 

Diff: 3 

Skill:  Word Chapter 1, Skill 1: Type Letter Text 

 

97) In documents created today, ________ space(s) should be typed at the end of a sentence. 

Answer:  one 

Diff: 2 

Skill:  Word Chapter 1, Skill 1: Type Letter Text 
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98) Customizing the errors flagged by the Spelling and Grammar checker is done in the 

________ dialog box. 

Answer:  Word Options 

Diff: 3 

Skill:  Word Chapter 1, Skill 2: Apply Styles and Set Grammar and Spelling Options 

 

99) All options on the Mini toolbar also appear in the ________ group of the Home tab. 

Answer:  Font 

Diff: 3 

Skill:  Word Chapter 1, Skill 3: Select and Insert Text 

 

100) When a single occurrence of a flagged error is actually correct, select ________ from the 

shortcut menu to leave this single flagged error unchanged. 

Answer:  Ignore Once 

Diff: 2 

Skill:  Word Chapter 1, Skill 6: Check Writing Style and Insert Synonyms 

Match each action with its result. 

 

A) Mini toolbar appears 

B) Dialog box appears 

C) Formatting marks appear 

D) Paste Options button appears 

E) Shortcut menu appears 

 

101) Selecting text 

Diff: 3 

Skill:  Word Chapter 1, Various Skills 

 

102) Clicking Show/Hide button 

Diff: 1 

Skill:  Word Chapter 1, Various Skills 

 

103) Inserting content from Clipboard 

Diff: 3 

Skill:  Word Chapter 1, Various Skills 

 

104) Clicking right mouse button 

Diff: 2 

Skill:  Word Chapter 1, Various Skills 

 

105) Clicking icon in the lower right corner of a Ribbon group 

Diff: 2 

Skill:  Word Chapter 1, Various Skills 

 

Answers: 101) A 102) C 103) D 104) E 105) B 
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Match each hot key with the action it performs. 

 

A) Undoes most recent edit in document 

B) Displays formatting marks 

C) Selects entire document 

D) Opens Spelling and Grammar checker 

 

106) F7 

Diff: 2 

Skill:  Word Chapter 1, Various Skills 

 

107) Ctrl + Z 

Diff: 2 

Skill:  Word Chapter 1, Various Skills 

 

108) Ctrl + A 

Diff: 2 

Skill:  Word Chapter 1, Various Skills 

 

109) Ctrl + * 

Diff: 3 

Skill:  Word Chapter 1, Various Skills 

 

Answers: 106) D 107) A 108) C 109) B 
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Match each File tab option with its function. 

 

A) Displays option for saving document as PDF file 

B) Displays page-by-page document preview 

C) Allows user to select storage location, folder, and file name for new document 

D) Makes saved file visible in Word document window 

E) Displays dialog box with options to change settings for various Word features 

 

110) Open 

Diff: 2 

Skill: Word Chapter 1, Various Skills 

 

111) Save As 

Diff: 2 

Skill:  Word Chapter 1, Various Skills 

 

112) Print 

Diff: 2 

Skill: Word Chapter 1, Various Skills 

 

113) Export 

Diff: 2 

Skill:  Word Chapter 1, Various Skills 

 

114) Options 

Diff: 2 

Skill:  Word Chapter 1, Various Skills 

 

Answers: 110) D 111) C 112) B 113) A 114) E 
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Skills for Success with Office 2013 Volume 1 (Townsend et al.) 

Access Chapter 1  Create Database Tables 

 

1) A(n) ________ is a collection of related information that displays in a single row of a database 

table. 

A) field 

B) record 

C) table 

D) object 

Answer:  B 

Diff: 2 

Skill:  Access Chapter 1, Skill 1: Create Databases 

 

2) ________ limits the number of characters that can be typed into a text or number field.  

A) Caption 

B) Column width 

C) Field size 

D) Field name 

Answer:  C 

Diff: 2 

Skill:  Access Chapter 1, Skill 2: Create Tables in Datasheet View 

 

3) A field that automatically enters a unique, numeric value when a record is created is a(n) 

________. 

A) primary key 

B) AutoNumber 

C) Best Fit 

D) Short Text 

Answer:  B 

Diff: 1 

Skill:  Access Chapter 1, Skill 3: Enter Data into Datasheets 

 

4) In a ________, the user can edit the primary key value in a table and all the related records in 

the other table will update accordingly. 

A) cascading update 

B) datasheet 

C) relationship report 

D) cascading delete 

Answer:  A 

Diff: 2 

Skill:  Access Chapter 1, Skill 5: Relate Tables 
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5) A(n) ________ displays related records from a table on the one side of the relationship. 

A) entity relationship 

B) macro 

C) subdatasheet 

D) design grid 

Answer:  C 

Diff: 3 

Skill:  Access Chapter 1, Skill 6: Enter Data in Related Tables 

6) If you will often import data from the same Excel workbook to Access, you can ________ the 

import steps. 

A) save 

B) delete 

C) overwrite 

D) export 

Answer:  A 

Diff: 3 

Skill:  Access Chapter 1, Skill 7: Import Data into Tables 

 

7) The ________ menu allows you to select records with the values you choose. 

A) Filter 

B) Context 

C) Tools 

D) Start 

Answer:  A 

Diff: 2 

Skill:  Access Chapter 1, Skill 8: Filter and Sort Datasheets 

 

8) ________ can be used to view a report before it is sent to the printer. 

A) Live Preview 

B) Design view 

C) Print Preview 

D) Datasheet view 

Answer:  C 

Diff: 2 

Skill:  Access Chapter 1, Skill 10: Preview and Print Datasheets 

 

9) Each column in a datasheet is a(n) ________ such as city, state, or postal code. 

A) field 

B) record 

C) query 

D) abstract 

Answer:  A 

Diff: 2 

Skill:  Access Chapter 1, Skill 1: Create Databases 
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10) The blank row of a table where new data is entered is called the ________ row. 

A) add 

B) new 

C) insert 

D) append 

Answer:  D 

Diff: 2 

Skill:  Access Chapter 1, Skill 1: Create Databases 

11) Database ________ store the data in rows and columns. 

A) forms 

B) tables 

C) reports 

D) objects 

Answer:  B 

Diff: 2 

Skill:  Access Chapter 1, Skill 1: Create Databases 

 

12) The first column of a new table is named ________. 

A) AutoNumber 

B) Name 

C) ID 

D) SS# 

Answer:  C 

Diff: 2 

Skill:  Access Chapter 1, Skill 1: Create Databases 

 

13) When creating a table, the ________ indicates what kind of information will be stored in a 

field. 

A) criteria 

B) layout 

C) Data Type 

D) caption 

Answer:  C 

Diff: 2 

Skill:  Access Chapter 1, Skill 2: Create Tables in Datasheet View 

 

14) When you save a table that has been added or changed, its name displays in the ________. 

A) title bar 

B) Navigation Pane 

C) status bar 

D) database file 

Answer:  B 

Diff: 2 

Skill:  Access Chapter 1, Skill 2: Create Tables in Datasheet View 
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15) Use the ________ button to adjust the entire datasheet's column widths at once. 

A) Select All 

B) Row Selector 

C) Column Border 

D) Select Records 

Answer:  A 

Diff: 2 

Skill:  Access Chapter 1, Skill 3: Enter Data into Datasheets 

16) The Date/Time data type stores data as ________. 

A) numeric values 

B) text 

C) serial numbers 

D) monetary values 

Answer:  C 

Diff: 2 

Skill:  Access Chapter 1, Skill 4: Create Tables in Design View 

 

17) An alternate method for creating a table is to create it in ________ view. 

A) Design 

B) Datasheet 

C) Layout 

D) Property 

Answer:  A 

Diff: 2 

Skill:  Access Chapter 1, Skill 4: Create Tables in Design View 

 

18) Records in two tables can be related by placing the same ________ in both tables. 

A) record 

B) field 

C) query 

D) property 

Answer:  B 

Diff: 1 

Skill:  Access Chapter 1, Skill 5: Relate Tables 

 

19) You can add tables to the Relationships tab by ________ them from the Navigation Pane. 

A) dragging 

B) pasting 

C) cutting 

D) duplicating 

Answer:  A 

Diff: 3 

Skill:  Access Chapter 1, Skill 5: Relate Tables 
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20) The Enforce Referential Integrity option is available from the ________ dialog box.  

A) File 

B) Get External Data 

C) Edit Relationships 

D) List 

Answer:  C 

Diff: 2 

Skill:  Access Chapter 1, Skill 5: Relate Tables 

21) Access draws a relationship ________ between two tables. 

A) line 

B) column 

C) pie 

D) bar 

Answer:  A 

Diff: 2 

Skill:  Access Chapter 1, Skill 5: Relate Tables 

 

22) You can ________ data from an Excel spreadsheet into an Access table by using the 

appropriate wizard. 

A) export 

B) import 

C) link 

D) embed 

Answer:  B 

Diff: 2 

Skill:  Access Chapter 1, Skill 7: Import Data into Tables 

 

23) While importing an Excel spreadsheet into Access, if the user chooses Append a copy of the 

records to the table but the table does not exist, Access will ________. 

A) create the table 

B) indicate an error 

C) create a link to the data 

D) erase the data 

Answer:  A 

Diff: 3 

Skill:  Access Chapter 1, Skill 7: Import Data into Tables 

 

24) Ascending order means records have been sorted by ________. 

A) the last-applied sort order 

B) default sort order 

C) smallest to largest value 

D) largest to smallest value 

Answer:  C 

Diff: 3 

Skill:  Access Chapter 1, Skill 8: Filter and Sort Datasheets 
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25) To filter records with the values you choose, your first step is to ________. 

A) clear the (Select All) check box 

B) uncheck each check box individually 

C) click the Erase button 

D) select Remove Filter 

Answer:  A 

Diff: 3 

Skill:  Access Chapter 1, Skill 8: Filter and Sort Datasheets 

26) To change the row color in a datasheet, click the ________ arrow from the Datasheet 

Formatting dialog box. 

A) Gridline Color 

B) Border and Line Styles 

C) Alternate Background Color 

D) Color Banding 

Answer:  C 

Diff: 3 

Skill:  Access Chapter 1, Skill 9: Format Datasheets 

 

27) The ________ command prints the object without letting you make adjustments. 

A) Print 

B) Quick Print 

C) Print Preview 

D) Print Properties 

Answer:  B 

Diff: 2 

Skill:  Access Chapter 1, Skill 10: Preview and Print Datasheets 

 

28) A layout that is taller than it is wide is ________. 

A) Portrait 

B) Custom 

C) Landscape 

D) Vintage 

Answer:  A 

Diff: 2 

Skill:  Access Chapter 1, Skill 10: Preview and Print Datasheets 

 

29) In Print Preview, if your document is more than one page, use the ________ to view the 

other pages. 

A) title bar 

B) status bar 

C) scroll bar 

D) navigation bar 

Answer:  D 

Diff: 2 

Skill:  Access Chapter 1, Skill 10: Preview and Print Datasheets 
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30) A table's page layout settings cannot be ________. 

A) saved 

B) changed 

C) opened 

D) previewed 

Answer:  A 

Diff: 2 

Skill:  Access Chapter 1, Skill 10: Preview and Print Datasheets 

 

31) The default file format for Access 2013 is Microsoft Access 2007-2013. 

Answer:  TRUE 

Diff: 2 

Skill:  Access Chapter 1, Skill 1: Create Databases 

32) Field names and captions must be the same.  

Answer:  FALSE 

Diff: 3 

Skill:  Access Chapter 1, Skill 2: Create Tables in Datasheet View 

 

33) Primary key field names often include ID to help identify them. 

Answer:  TRUE 

Diff: 2 

Skill:  Access Chapter 1, Skill 3: Enter Data into Datasheets 

 

34) The Currency data type stores numbers formatted as monetary values. 

Answer:  TRUE 

Diff: 1 

Skill:  Access Chapter 1, Skill 4: Create Tables in Design View 

 

35) Referential integrity rules allow you to enter a Contractor ID that does not exist in the related 

Contractors table. 

Answer:  FALSE 

Diff: 3 

Skill:  Access Chapter 1, Skill 6: Enter Data in Related Tables 

 

36) An Excel worksheet CANNOT be imported into a new table.  

Answer:  FALSE 

Diff: 2 

Skill:  Access Chapter 1, Skill 7: Import Data into Tables 

 

37) The sort order and filter that a user creates in a datasheet are saved as a part of the table's 

design. 

Answer:  TRUE 

Diff: 2 

Skill:  Access Chapter 1, Skill 8: Filter and Sort Datasheets 
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38) You can hide a field in a datasheet.  

Answer:  TRUE 

Diff: 1 

Skill:  Common Features, Skill 9: Copy and Paste Objects and Format Slides 

 

39) A table's page layout settings can be saved so they are applied the next time the table is 

opened. 

Answer:  FALSE 

Diff: 2 

Skill:  Common Features, Skill 9: Copy and Paste Objects and Format Slides 

 

40) Reuse a database is an option on the Access start page. 

Answer:  FALSE 

Diff: 2 

Skill:  Access Chapter 1, Skill 1: Create Databases 

 

41) When you create a blank database, a new table is automatically started for you. 

Answer:  TRUE 

Diff: 2 

Skill:  Access Chapter 1, Skill 1: Create Databases 

42) You can assign a name and location for the database file any time after entering data. 

Answer:  FALSE 

Diff: 2 

Skill:  Access Chapter 1, Skill 1: Create Databases 

 

43) A datasheet displays records in rows and columns similar to an Excel spreadsheet. 

Answer:  TRUE 

Diff: 2 

Skill:  Access Chapter 1, Skill 1: Create Databases 

 

44) Column widths CANNOT be changed to match the width of their contents. 

Answer:  FALSE 

Diff: 2 

Skill:  Access Chapter 1, Skill 2: Create Tables in Datasheet View 

 

45) You do not need to save new or changed data before navigating to a new record. 

Answer:  TRUE 

Diff: 2 

Skill:  Access Chapter 1, Skill 3: Enter Data into Datasheets 

 

46) Once an AutoNumber value has been assigned, it CANNOT be changed. 

Answer:  TRUE 

Diff: 2 

Skill:  Access Chapter 1, Skill 3: Enter Data into Datasheets 
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47) When you close a database table, the database closes. 

Answer:  FALSE 

Diff: 2 

Skill:  Access Chapter 1, Skill 3: Enter Data into Datasheets 

 

48) A foreign key is often the second table's primary key. 

Answer:  TRUE 

Diff: 2 

Skill:  Access Chapter 1, Skill 4: Create Tables in Design View 

 

49) Table Design view is a view that features table fields and their properties. 

Answer:  TRUE 

Diff: 2 

Skill:  Access Chapter 1, Skill 4: Create Tables in Design View 

 

50) In Design view, the Field Name, Data Type, and Description data are entered in rows. 

Answer:  TRUE 

Diff: 2 

Skill:  Access Chapter 1, Skill 4: Create Tables in Design View 

 

51) With a cascading update, the user can edit the primary key value in a table, and all the related 

records in the other table will update. 

Answer:  TRUE 

Diff: 2 

Skill:  Access Chapter 1, Skill 5: Relate Tables 

52) A relationship where a record in the first table can have many associated records in the 

second table is called a many-to-many relationship. 

Answer:  FALSE 

Diff: 2 

Skill:  Access Chapter 1, Skill 5: Relate Tables 

 

53) One-to-many relationships enforce referential integrity. 

Answer:  TRUE 

Diff: 3 

Skill:  Access Chapter 1, Skill 5: Relate Tables 

 

54) The Date Picker feature allows the user to enter dates by clicking on a calendar. 

Answer:  TRUE 

Diff: 1 

Skill:  Access Chapter 1, Skill 6: Enter Data in Related Tables 

 

55) When a table is on the many side of a relationship, a subdatasheet is available that displays 

related records from the one side of the relationship. 

Answer:  FALSE 

Diff: 3 

Skill:  Access Chapter 1, Skill 6: Enter Data in Related Tables 
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56) An Excel worksheet that organizes data into rows and columns can be imported into an 

existing table. 

Answer:  TRUE 

Diff: 2 

Skill:  Access Chapter 1, Skill 7: Import Data into Tables 

 

57) When you import data from Excel, it is best practice to insert the table's field names in the 

spreadsheet's header row. 

Answer:  TRUE 

Diff: 2 

Skill:  Access Chapter 1, Skill 7: Import Data into Tables 

 

58) While importing an Excel spreadsheet into Access, if the user chooses Append a copy of the 

records to the table and the table exists, Access will add the records to the table.  

Answer:  TRUE 

Diff: 2 

Skill:  Access Chapter 1, Skill 7: Import Data into Tables 

 

59) If an Excel workbook contains multiple worksheets, it will automatically import Sheet1. 

Answer:  FALSE 

Diff: 2 

Skill:  Access Chapter 1, Skill 7: Import Data into Tables 

 

60) In the Import Spreadsheet Wizard, it is not necessary to view sample data or verify that the 

field names in the header row match. 

Answer:  FALSE 

Diff: 2 

Skill:  Access Chapter 1, Skill 7: Import Data into Tables 

61) Records in a table are sorted by their primary key. 

Answer:  TRUE 

Diff: 1 

Skill:  Access Chapter 1, Skill 7: Import Data into Tables 

 

62) The direction of the sort arrow at the top of a column indicates whether an ascending or 

descending sort was performed. 

Answer:  TRUE 

Diff: 3 

Skill:  Access Chapter 1, Skill 8: Filter and Sort Datasheets 

 

63) If you have applied and saved a filter to a datasheet, the filter will be applied each time you 

open the table.  

Answer:  FALSE 

Diff: 2 

Skill:  Access Chapter 1, Skill 8: Filter and Sort Datasheets 
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64) When a user changes the font or font size in a datasheet, changes are applied only to the 

column where the insertion point was located when the change was made.  

Answer:  FALSE 

Diff: 2 

Skill:  Access Chapter 1, Skill 9: Format Datasheets 

 

65) Landscape is a layout that is wider than it is tall. 

Answer:  TRUE 

Diff: 2 

Skill:  Access Chapter 1, Skill 10: Preview and Print Datasheets 

 

66) The Print command enables you to select different print options. 

Answer:  TRUE 

Diff: 2 

Skill:  Access Chapter 1, Skill 10: Preview and Print Datasheets 

 

67) To print data from a table, a user typically creates a report. 

Answer:  TRUE 

Diff: 2 

Skill:  Access Chapter 1, Skill 10: Preview and Print Datasheets 

 

68) If the buttons on the navigation bar are dimmed, the table will print on more than one page. 

Answer:  FALSE 

Diff: 2 

Skill:  Access Chapter 1, Skill 10: Preview and Print Datasheets 

 

69) Portrait is the default view that is applied each time a table is opened. 

Answer:  TRUE 

Diff: 2 

Skill:  Access Chapter 1, Skill 10: Preview and Print Datasheets 

 

70) You must save your data and database objects before quitting Access. 

Answer:  FALSE 

Diff: 1 

Skill:  Access Chapter 1, Skill 10: Preview and Print Datasheets 

71) The ________ row is a row of a table in which a new record can be entered.  

Answer:  append 

Diff: 2 

Skill:  Access Chapter 1, Skill 1: Create Databases 

 

72) A set of fields that can be added to a table with a single click are called ________ Start data 

types.  

Answer:  Quick 

Diff: 2 

Skill:  Access Chapter 1, Skill 2: Create Tables in Datasheet View 
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73) A(n) ________ key is a field used to relate records in a second table. 

Answer:  foreign 

Diff: 2 

Skill:  Access Chapter 1, Skill 4: Create Tables in Design View 

 

74) ________ view lists all the fields with their data types and properties but not actual records.  

Answer:  Design 

Diff: 3 

Skill:  Access Chapter 1, Skill 4: Create Tables in Design View 

 

75) ________ integrity is a rule that keeps related values synchronized.  

Answer:  Referential 

Diff: 2 

Skill:  Access Chapter 1, Skill 5: Relate Tables 

 

76) The feature that allows a user to enter dates into Date/Time fields by clicking on a calendar is 

called the Date ________.  

Answer:  Picker 

Diff: 2 

Skill:  Access Chapter 1, Skill 6: Enter Data in Related Tables 

 

77) You can ________ data from an Excel spreadsheet into an Access table. 

Answer:  import 

Diff: 1 

Skill:  Access Chapter 1, Skill 7: Import Data into Tables 

 

78) The column ________ changes to indicate that records have been sorted. 

Answer:  arrow 

Diff: 3 

Skill:  Access Chapter 1, Skill 8: Filter and Sort Datasheets 

 

79) The database object that stores the data is a(n) ________. 

Answer:  table 

Diff: 2 

Skill:  Access Chapter 1, Skill 1: Create Databases 

 

80) The name ________ is temporarily assigned to the new table that opens automatically when 

a blank database is created. 

Answer:  Table1 

Diff: 2 

Skill:  Access Chapter 1, Skill 1: Create Databases 

81) If a field of data needs to hold 200 characters, you should use the ________ data type. 

Answer:  Short Text 

Diff: 3 

Skill:  Access Chapter 1, Skill 2: Create Tables in Datasheet View 
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82) ________ determine what displays in all datasheet, form, and report labels. 

Answer:  Captions 

Diff: 2 

Skill:  Access Chapter 1, Skill 2: Create Tables in Datasheet View 

 

83) ________ limits the number of characters that can be typed into a text or number field. 

Answer:  Field size 

Diff: 2 

Skill:  Access Chapter 1, Skill 2: Create Tables in Datasheet View 

 

84) A field that uniquely identifies each record in a table is called the ________. 

Answer:  primary key 

Diff: 2 

Skill:  Access Chapter 1, Skill 3: Enter Data into Datasheets 

 

85) A field that automatically enters a unique, numeric value when a record is created is a(n) 

________ field. 

Answer:  AutoNumber 

Diff: 2 

Skill:  Access Chapter 1, Skill 3: Enter Data into Datasheets 

 

86) The ________ data type stores numeric values. 

Answer:  Number 

Diff: 2 

Skill:  Access Chapter 1, Skill 4: Create Tables in Design View 

 

87) When you join tables, the common fields must share the same ________. 

Answer:  data type 

Diff: 2 

Skill:  Access Chapter 1, Skill 4: Create Tables in Design View 

 

88) A relationship where a record in one table can have many associated records in a second 

table is a(n) ________ relationship. 

Answer:  one-to-many 

Diff: 2 

Skill:  Access Chapter 1, Skill 5: Relate Tables 

 

89) With a(n) ________, if the user deletes a record on the one side of the relationship, all the 

related records on the many side will also be deleted. 

Answer:  cascading delete 

Diff: 2 

Skill:  Access Chapter 1, Skill 5: Relate Tables 
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90) When entering data in related tables, a foreign key value must have a(n) ________ value in 

the related table. 

Answer:  matching 

Diff: 2 

Skill:  Access Chapter 1, Skill 6: Enter Data in Related Tables 

 

91) The ________ allows the user to import records from an Excel spreadsheet into an Access 

table. 

Answer:  Import Spreadsheet Wizard 

Diff: 2 

Skill:  Access Chapter 1, Skill 7: Import Data into Tables 

 

92) Datasheets can be sorted and ________ to make the information useful. 

Answer:  filtered 

Diff: 2 

Skill:  Access Chapter 1, Skill 8: Filter and Sort Datasheets 

 

93) In the Datasheet Formatting dialog box, a(n) ________ of the selected formatting displays. 

Answer:  sample 

Diff: 2 

Skill:  Access Chapter 1, Skill 9: Format Datasheets 

 

94) Specific fields in a datasheet can be ________. 

Answer:  hidden 

Diff: 2 

Skill:  Access Chapter 1, Skill 9: Format Datasheets 

 

95) ________ can be used to see what a report will look like without actually printing it. 

Answer:  Print Preview 

Diff: 2 

Skill:  Access Chapter 1, Skill 10: Preview and Print Datasheets 
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Match each definition with the appropriate term. 

 

A) Expand row 

B) Append row 

C) Junction key 

D) Subdatasheet 

E) Worksheet 

F) Foreign key 

G) Primary key 

H) Datasheet 

I) Composite key 

J) Subordinate 

 

96) Displays data in rows and columns similar to an Excel spreadsheet 

Diff: 2 

Skill:  Access Chapter 1, Skill 1: Create Databases 

 

97) Where a new record is added to a table 

Diff: 2 

Skill:  Access Chapter 1, Skill 1: Create Databases 

 

98) Field that uniquely identifies each record in a table 

Diff: 2 

Skill:  Access Chapter 1, Skill 3: Enter Data into Datasheets 

 

99) Field used to relate records in another table 

Diff: 2 

Skill:  Access Chapter 1, Skill 4: Create Tables in Design View 

 

100) Displays related records from the table on the many side of the relationship 

Diff: 2 

Skill:  Access Chapter 1, Skill 6: Enter Data in Related Tables 

 

Answers: 96) H 97) B 98) G 99) F 100) D 
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